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Introduction    
The CR Access System is a PC application that gives access to Vidicode 
Call Recorders on a network.  
The program can retrieve the contents of Call Recorders and present 
them as a database. A selection of the recordings or all recordings can 
be downloaded to the PC and can be played using the loudspeakers of 
the PC. Using the software is the most common way to work with and 
listen to the recordings. 
The Access System can be used as a back up system for the Call 
Recorders. It supports automated transfers to network drives and it can 
be used to give other users on the network access to stored databases of 
recordings. 
The software includes various tools to work with the recordings such as 
a statistics module to analyze the telephone traffic of an organization, a 
tool to make back-ups on CD’s and an optional module to convert 
recordings of fax transmissions back into the original document. 
The Access System also supports the use of Call Recorder Crypto Cards in 
a USB card reader. 
To use the software a network connection is required. Normally this will 
be a connection to recorders on the same network. Alternatively it can 
be to databases of recordings stored on network drives. 
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1 Menu and buttons 

To be able to work with this software in an effective way, it is necessary 
to know what can be found where. Although we have tried to make the 
software as intuitive as possible, we think it is useful to provide some 
explanation.  

1.1 Menu 
The Call Recorder Access System has 7 menu’s 
See figure below: 
 

 
How to work with the menu is described in § 3 “Working with the Acces 
System”  The Tools menu option is described in § 2.2 Configuration.  

1.2 The Play back section 
The software has recorder buttons, volume controls and  buttons to 
access and handle the database, CD’s, statistics etc.  

1.2.1 Recorder buttons 

 
1. Rewind 60 sec. 
2. Play/pause 
3. Stop 
4. Forward 60 sec.  
 

The playback tool buttons basically have the same functionality as in all 
standard media players 
 

1.2.2 Display and volume control 

 
1. Display 
2. Volume control 
3. Mute 
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The displaydisplaydisplaydisplay will show the Name and Telephone number of the recording 
being played, the position in the recording you are at and the total 
duration of the call.  
 

 
The playback section has a sliderslidersliderslider and a button in the slider. The slider is 
used to adjust the volume. The button in the slider can be used to 
change the playback position. 

The mutemutemutemute button alternates between Mute off  and Mute on 

 

1.2.3 The tool buttons 
The tool buttons perform the following functions: 
 

 
1. Update database 
2. Transfer to PC, Selected records 
3. Transfer to PC, Marked records 
4. Transfer to PC, All records  
5. Delete selection  
6. Stop ongoing transfer of records or recordings 
7. Send in e-mail 
8. Lock program  
9. Open in Sound Editor 
10. Statistics 
11. Add to CD Archives 
12. Options 
13. View Fax 
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1.2.4 Status icons  
Once the list of recordings has been retrieved, it is possible to tell 
whether a recording has been downloaded or not, if it is marked to be 
downloaded and if it was an incoming or an out going call, by the icons 
displayed next to the other information.  

 
 

 is the icon for “In recorder”. The recording has not (yet) been 
downloaded to the PC. 

 is the icon for “Marked”. The recording has been marked to 
download to the PC any other time.  

 is the icon for “Downloaded”. The recording has been 
downloaded to the PC and can be played back, attached to an e-mail 
etc.  

 is the icon for “Outgoing call” 

 is the icon for “Incoming call” 
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2 Software installation and configuration 

2.1 Installation 
The CR Access System has been tested on Microsoft Windows XP, 
Windows Vista, Windows 7 & 8.  
 
To install you must run the setup module from CD (the Vidicode 
Application Disk) or from our web server. To install the software, first 
select the language for the setup program. The initial dialogue may 
appear in another language (usually the language of your system). 
 
The next steps are the acceptance of the license agreement, entering 
user information and the Licence Key. This Licence Key can be found on 
the letter accompanying the Installation disk and manual.   
 
Next you will be prompted to enter the location of the program files, 
the program’s shortcuts and if you want the Setup program to create a 
desktop icon for the CR Access System or not. 
 
NOTE: Consider where you want to store the Database and SettingsNOTE: Consider where you want to store the Database and SettingsNOTE: Consider where you want to store the Database and SettingsNOTE: Consider where you want to store the Database and Settings 
The option is to store the Database and Settings in a custom location. 
The default location is in your ‘My Documents’ folder. There are three 
possible reasons to opt for a custom location: 
 

• If you are working on a PC that has more than one user and you 
want to avoid that there will be different databases and 
configurations for different users 

• If you plan to store a large amount of data, many recordings, in 
the databases and you expect that the amount of data will not fit 
into your ‘My Documents’ Folder 

• If you plan to give others remote access to the database, which 
normally will not be possible with your My Documents folder 

 
Usually the ‘My Documents’ folder will be the right choice. 
 
Now the Setup program will present your choices and ask you if you are 
ready to install the program. When you accept the program will be 
installed on your PC.



 

2.2 Configuration 
The configuration that is required depends on the way the program is 
used. 
Normally you will use the Access System to connect to the Call Recorders 
on your network. In this case the network address, the password and the 
name of the recorder must be set. 
The alternative way to use the program is to open a remote database 
created by another user of the CR Access System. 

2.3 Connections 
To connect to a Call Recorder a network connection between the PC and 
the recorder is required. Provided all the links are made and there are 
no firewalls that prevent the access, even a connection across the 
internet is possible. 
 
Start the Call Recorder Access System by clicking the Icon on the 
desktop.  
It will look similar to the picture below. The call database is still empty. 
 



 

2.4 Language 
If you want the software to be displayed in any other language than 
English, start with changing the language before you go ahead with the 
configuration. The software’s language can be changed on any given 
moment, but for the purpose of the configuration it may be easier to 
start with setting the language.  

 
• Open the Menu Tools – Language and click on the desired 

language.  
At this moment you can choose: French, UK English, US English, German, 
Dutch, Italian and Spanish. 

2.5 FTP Profile 
The software has to communicate with the call Recorder. The first thing 
you need to do is make the FTP connection as described below.  

• Select Tools from the menu.  

• Select Options 

• Select FTP Profiles. 

• Click New   



 
The following dialogue will appear: 

 
 
Here you must fill in the fields that contain the Recorder name, IP name 
or address, FTP ID, FTP Password and Port number (default 21).  
 

• Fill in the Recorder name, This can be any name it is usually easier 
to remember a name than a number.  

• Fill in the IP Name or IP address. Your systems operator can give 
you the IP address of the recorder or you must find it yourself 
using the LAN menu of the recorder(s). 

• The FTP ID is usually 0000 

• The FTP password can be a general password for this recorder or a 
password specific for you, which will restrict the downloads you 
can make to only your own conversations.  Further information on 
this topic can be found in de Call Recorder’s manual.  

• By default the check box “Allow access to the recorder” is 
checked.  

• The port number is usually 21, ask your Systems operator which 
number is should be if 21 does not work.  

• The Reset timeframe button allows you to change the first date 
from which the software will list the recordings.  

• Click OK if you are satisfied with the FTP profiles. 



2.6 Link to Recorder 
Now you have linked the software, via FTP to one or more  specific Call 
Recorders. The specifications of the connections can be set in Options – 
Link to Recorders  
 
There are four windows in this dialogue:  
Communications Log, FTP Link Time out, FTP Passive Protocol and Fax 
Connection Options.  

 

2.6.1 Communications Log 
To keep track of the network communication taking place between the 
PC and the Call Recorders, it is possible to show the network 
communication (FTP) details at the bottom of the main window.  

• In the menu choose View – Network Communication Details to 
enable this feature.  

• Check Log to File to make a copy of the logging.  
The log file is called ‘FTP.log’ and is usually located in the Archives 
directory (default My Documents\CallRecorderArchives). Every time the 
application is started, the log file is cleared.  
With the Menu option View – Network Communication Details it is 
possible to follow the transfer on screen. You will see: 
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In the figure above the lower part of the dialogue shows the Network 
Communication Details. 

2.6.2 FTP Link Time out 
The Time out for the FTP connection to the recorders can be set. FTP 
time out can be low if you are on a local network (LAN), e.g. 10 -30. 
When connecting to recorders on a large network the time out should 
be raised to 60 or 90, when the connection is via Internet, raise the time 
out to 120.  

2.6.3 FTP Passive protocol 
Enable FTP passive protocol only when the software has a problem 
accessing the call recorder because of a firewall locking the FTP 
communication.   

2.6.4 Fax options 
When the option Fax recording is installed on the call recorder, 
recordings of fax transmissions can be converted by the Call Recorder 
Access System back to the original image. The following options are 
available.  

2.6.5 Delete Source after conversion  
This will delete the audio record after successful conversion to fax 
image. The fax image will be attached to the record in the database.  
Convert after automatic download Convert after automatic download Convert after automatic download Convert after automatic download     
Will convert all the recordings of fax transmissions into the original 
image after automatic download of the recordings.  
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2.6.6 Stop searching when no fax found after Max seconds.  
Set a maximum time for the converter to probe a recording for a fax 
transmission. When a combined answering machine / fax machine is in 
use, it could take a relatively long time for a fax transmission in a 
recording to start.  

• Click Apply after you are satisfied with the options set.  

2.6.7 Configure the recorder and the software for fax 
Faxes can only be reproduced from the original audio signal of the fax 
transmission. Therefore in the configuration of the Call Recorder audio 
compression must be switched off for the fax lines. 
In the database Faxes will be identifiable by Compression, it reads 
Recorder Fax G 7.11 

2.6.8 Change the access to a listed recorder 
To change access to a recorder  

• Click on the folder icon.  
When open, the recorder can be accessed with the access system. When 
closed, the software can not access the recorder. The recorder will 
however remain listed in the database of recorders and the access can 
be re-established by opening the folder icon. 

2.6.9 Remove a recorder 

• Select a recorder in the list  

• press the Delete buttonDelete buttonDelete buttonDelete button. 

  
 
The program will ask for acknowledgement before clearing the profile 
from the list. 

2.6.10 Reset Timeframe 
The CR Access System keeps track of the last retrieved record while 
updating the database. This is used to be able to add new calls only to 
the database.  
 
When you start a new database, you may want to reset the timeframe 
for the recorder. Please refer to § 4.3.1 for more information.  
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2.7 Display 
In the display dialogue the user can specify which database columns he 
wants to be visible. For instance: Date & time, Internal number, Note’s 
etc. 
 In the lower part of the dialogue the Grid Preferences can be set.  

• Check “Can change Column Order” if you want to be able to put 
columns more to the right or left.  

After changing the column order this check will disappear, should you 
want to change the column order again, you have to check this option 
again.  

• Check the option “Auto Size Columns” if you want the software 
to size the columns to fit the window.  

• Click Apply after you are satisfied with the options set.  
 

 
 

2.8 Security and CD’s 
The security and CD’s part is an important part of protecting the Call 
Recorder Access System from unauthorised usage.  
Protecting the actual recordings can be arranged using encryption, this 
is possible if you purchased one or more CryptoCard sets.  
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2.8.1 Password software 
To set a password for entering the software, the user must be identified 
first. By default User 0 is the supervisor. The Supervisor can set 
usernames and passwords for other users.  
Initially the password for supervisors is 000000. This should be altered by 
the supervisor at first use.  

• Select a user (that has not been named yet) from the dropdown 
box 

• Click the Edit User button 

• Enter the Username 

• Enter the Password (6 positions use at least 2 digits and 2 
characters) 

• Enter the Password again for confirmation 

• Click the Save user button 
Repeat this sequence for every user.  

2.8.2 Password Options 

• Check the checkboxes Ask on Start up and Ask to Unlock.  
 

NOTE: Should you not check these checkboxes the users will still be able 
to open the Application without entering the Password.  
Once a password has been set, and the check boxes checked, it will be 
asked for on start up of the software and  to unlock the application 
after it has been locked manually using the Lock button in the tool bar. 
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2.8.3 CryptoCard Functions 
If you purchased CryptoCards as an option with your call recorder, and 
you use an external (USB) Crypto Card Reader, you should check the 
checkbox “Use Card Reader’.  The PIN code timeout is set in minutes, It 
allows you to perform several actions on one or more encrypted 
recordings before the PIN code is asked again. The PIN code will be 
asked again after the specified time.  
 

2.8.4 Building CD Archives 
With this option the maximum size of the CD archive can be set. This 
value is set at 700Mb by default, because that is the most common CD-R 
size. Should you use CD-R with another capacity, it is advised to modify 
the maximum CD size to match the capacity of the CD-R you are using.  
    

2.9 Data Storage 
The Archives directory is the default location where new Archives are 
created. The path will be set to C:\ Documents and Settings\user\My 
documents\CallRecorderArchives. If you want the Archives to be stored 
at another location, specify the path here.  
The Options path is the location where the main settings of the Call 
Recorder Access System itself are stored.  

• Use the Browse button to find another location.  

• After changing the Data storage location, you will have to restart 
the Call Recorder Access System.  

(Secondary settings are stored in APPDATA%\Vidicode\CRAccess) 
Multi UserMulti UserMulti UserMulti User    
If an Archive is to be shared between to people using different PC’s, 
both users should set the same paths for Data Storage and Options.  
Both Archives and Options should be stored on your PC or Network.  
 

2.10 Schedule 
Some options can be scheduled, like Unattended download of 
recordings, or unattended download of Listing of recordings and the 
deletion of expired data. The start up procedure can be specified.  
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• Check ‘After every’ and  

• Choose the desired interval. 
 If you want to download only the Listing, not the actual recordings, also 

•  check Download Listings only. 
    

Startup proceduresStartup proceduresStartup proceduresStartup procedures    
‘Minimize program on start-up’ places the application in the System 
Tray. The program can be started in three different ways.  
- Automatically when any user signs on 
- Automatically when the current user signs on  
- Manually 
The program can not start if no user signed on in Windows.  
Removal of expired dataRemoval of expired dataRemoval of expired dataRemoval of expired data    
In some countries and situations it is obligatory to remove recordings 
after a set amount of time.  
In the Call Recorder Access System there are two options for automatic 
removal: 

• Automatic removal on program exit. 
Which means all recordings will be erased from the database when you 
close the application, and 

• Number of days until data are removed.  
Specify the amount of days before the recordings are erased from the 
system. 

Click Apply after you are satisfied with the options set.  
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3 Working with the Access system 

When you have completed the installation and configuration of the 
application, you can start working with it. 
First of all you will have to download the listing of recordings from the 
Call recorder(s) your Access system is connected to.  
 

 
 

Now you can use the  [Update Database] button  
 
or the [Update list of recordings] button in the Download section of the 
left menu, to download the listing (not the actual recordings) to the PC.  
 
Once you have downloaded the listing, several different actions can be 
done on the database.  
Some or all recordings can be downloaded to the PC (note that 
downloading all recordings might take a considerable amount of time). 
 
All actions can be started from the Main Menu or using the right mouse 
click or using the tool buttons above the listing. 
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3.1.1 Lay-out of the program 
The lay-out of the program is divided in five sections. The menu bar, the 
playback section,  the tool buttons, the archive and search tabs and the 
listing in the main screen.  

3.2 The Archive tab 
The archive tab has two sections and six shortcut buttons.  
 
In the DownloadDownloadDownloadDownload section the short cut buttons are: 
[Update list of recordings], 
[Download selection] and  
[ Stop action].  
 
In the ArchiveArchiveArchiveArchive section of the tab the shortcut buttons are:  
[View archive browser],  
[Select main archive] and  
[Select recycle bin] 
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3.2.1 View Archive Browser 
 
The archive browser is used to select archives. It allows you keep track of 
four types of archives. 
 
The Main ArchiveMain ArchiveMain ArchiveMain Archive is the archive that you are working with when you are 
connected to one or more Call Recorders 
 
The Closed ArchivesClosed ArchivesClosed ArchivesClosed Archives are earlier used main archives. It is a list of all 
archives in your archive directory. The idea is that, after a while, you 
close an archive so it doesn’t become too large to handle. 
 
The Remote ArchivesRemote ArchivesRemote ArchivesRemote Archives are read only archives. Usually remote archives are 
archives placed on a server. They can be the Main Archive and Closed 
Archives of another user. This can be useful if many users want to have 
access to the recorded calls. 
 
The Recycle BinRecycle BinRecycle BinRecycle Bin is an archive used as the intermediate state when you 
delete a recording from an archive. 
 

3.2.2 The selected archive 
The selected archive is shown as a list of all recordings. The archive is a 
database. Every row in the archive represents a record of a call. The 
various properties of the records are distributed over corresponding 
columns. 
 
Use the Shortcut button [ Select Main Archive] to go back to the main 
archive. 

3.2.3 To open a remote archive 
Remote Archives are read-only archives for viewing and play back. When 
an archive is shared by multiple users, only one of them should update 
the database.  
To open a remote archive, you must create a link to it. 

• Select ‘Archive’ from the menu bar and then ‘Remote Archives’ 
and  ‘Add link to Archive Browser’. 
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• Select a directory where the dialogue indicates an archive. If there 
is no valid archive in the directory, the dialogue will indicate ‘No 
archive in this directory’. 

 

 
• Click OK to confirm.  

This Archive can now be chosen to be the main archive.  
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In the example we have opened the Archive browser. Click on the 

Archive Icon  to open the remote archive.  
 
Once you have opened the archive, you can make it the Main Archive  

• Go to main Menu -> Archive -> Remote Archives and  

• select the option Remote is my main Archive.  
        

3.2.4 Select Main Archive 
The Shortcut button Select Main Archive can be used to go back to the 
Main Archive immediately, after you have selected a Closed or Remote 
Archive earlier, for instance to search for a specific recording. Read more 
about the search function in §5.2  
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3.3 Working with the Archive 
What you see is a listing of the records in the database. The listing 
provides information about the recording. (Date and Time, Duration etc) 
The icons show whether a recording is on the Call Recorder or has 
already been downloaded to your PC.  
An archive may look like the following: 
 

 
 
Archives can be quite large. Therefore you may want to reduce the 
number of records shown in the list by applying a query as explained in  
§ 5.2  

3.3.1 Update Database 
There are four different ways to Update the list of recordings. 
Automatically, Via the menu, Using the shortcut button or Using the 
tool button.  
The function Update databaseUpdate databaseUpdate databaseUpdate database retrieves all new records from the Call 
Recorders 
If you selected automatic downloading of recordings, or listing or 
recordings in Tools -> Options -> Schedule (see also §2.10 ) the 
download will be automatically.  
Otherwise 

• Choose ActionActionActionAction in the menu. 

• Select UpdateUpdateUpdateUpdate DatabaseDatabaseDatabaseDatabase. 
or 
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• Press   (The Update Database tool button). 
or 

• Press   (Update list or recordings shortcut).   
 
The CR Access System keeps track of all records in the database. The 
Update Database function retrieves only the new records from the Call 
Recorders.  
This function only works when there is a connection to one or more Call 
Recorders and when the Main Archive is selected. Remote and Closed 
archives are for Viewing and Play back only.  

3.4 Records and Recordings 
When updating the list of records manually the recordings are not 
downloaded yet.  
If you want to download one or more of the actual recordings, there are 
different ways to go about it.  
 
A selection of records can be made of which you want to download the 

actual recordings. A record is depicted with the   icon, the actual 
recording has not been downloaded. Once the recording of the record 

has been downloaded the icon is replaced with the   icon. Records 

marked to be downloaded later are depicted with the  icon  

3.4.1 Download  recordings immediately 
Downloading a recording can be done in three different ways. Using the 
shortcut button, using the Tool button or using the Menu.  

• Select the records that you want to download the recordings from. 

A selection can be made using the PC’s mouse and keyboard,  

• Select the first record, keep the CRTL key pressed and select the 
next records,  

or  

• Select the first record, keep the SHIFT key pressed and select the 
last record, all records in between the first and the last will be 
selected as well.  

or 

• Make a selection using the Search tab. (see § 5 ) 
To start downloading the recordings:  

• Choose ActionActionActionAction in the menu.  
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• Choose Transfer to PC. 

• Choose Selected records. 
or 

• Press the   (Transfer to PC, Selected records Tool button) 
or  

• Press the  (Download selection shortcut 
button) 

 
The status bar, below the listing will keep you informed about the 
download action. (see figure below) 

 
 

3.4.2 Mark to download later 
It is also possible to mark a selection of records to download the 
recordings at a later time. See § 3.4.1 and § 5 on selecting and searching) 
To mark a recording to be downloaded at a later time. 
 

• Select the records you want to download the recordings of. 

• Choose Action in the menu. 

• Choose Select for transfer to PC. 

• Choose Selection. 
Or 

• Select one or more recordings,  

• Right click  

• Choose Select for transfer to PC 

• Choose Selection.  
 

The marked records can be identified by the  icon. 
The actual downloading can be started as follows: 

• Either use the  ( transfer to PC, Marked records tool button ) 
or 

• Choose Action in the menu. 

• Choose Transfer to PC. 

• Choose Marked records. 
Or 

• Right click  

• Choose Transfer to PC 

• Choose Marked Records 
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All records marked with the  icon the recordings will be 
downloaded. 
 
NOTENOTENOTENOTE: It is always possible to deselect records.  

• Choose Action in the menu. 

• Choose Select for transfer to PC. 

• Choose Deselect All. 
Or 

• Right click  

• Choose Select for transfer to PC. 

• Choose Deselect All. 

3.4.3 Download all recordings 
NOTE: Downloading all recordings may take a considerable amount of NOTE: Downloading all recordings may take a considerable amount of NOTE: Downloading all recordings may take a considerable amount of NOTE: Downloading all recordings may take a considerable amount of 
time, depending on thtime, depending on thtime, depending on thtime, depending on the number of recordings and the duration of the e number of recordings and the duration of the e number of recordings and the duration of the e number of recordings and the duration of the 
recordings. recordings. recordings. recordings.     
 
There are three different ways to download all recordings.  

• Press the  ( Transfer to PC, All records tool button ) 
or 

• Choose Action in the menu 

• Choose Transfer to PC 

• Choose All records 
or 

• Right click  

• Choose Transfer to PC 

• Choose All records 

3.4.4 Removing records 
It is possible to delete one or more records. They will be put in the 
program’s ‘Recycle Bin’. This is not the Windows Recycle bin.  

• Make a selection of records you want to delete. 

• Choose Action in the menu. 

• Choose Delete selection. 

This action can also be performed using the tool button  [Delete 
Selection] or by right clicking and choosing the option Delete Selection.  
 
All selected records will be moved to the ‘Recycle Bin’ of the program. 
See § 4.6 for explanation about the ‘Recycle Bin’. 
 
In the same way records in the ‘Recycle Bin’ can be restored to the 
current archive.   
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• Make a selection of records that you want to restore. 

• Choose Action in the menu. 

• Choose Restore selection. 
or 

• Right click or and choose the option Restore Selection. 
NOTENOTENOTENOTE Restored records are moved to the current (read most recently 
activated) archive. 
 

3.4.5 Play back of recordings 
A recording can be played back from the Call Recorder of from the PC. .   
 
There are two options to play back a recording; using the play back 
section in the Call Recorder Access System, or using the Sound editor.  
 
Play Play Play Play backbackbackback using the Call Recorder using the Call Recorder using the Call Recorder using the Call Recorder Access System Recorder buttons Access System Recorder buttons Access System Recorder buttons Access System Recorder buttons    

• Select the recording 

• Press  (the Play / pause button) to start playback. 
 
When the recording is already downloaded to the PC it will play 
immediately. A recording that has not been downloaded can be played 
if  there is an enabled network connection with the recorder. The 
recording will be stored in the cache of the PC. It only takes a moment 
to download one recording. 
 
Play backPlay backPlay backPlay back    in the Sound editorin the Sound editorin the Sound editorin the Sound editor    

• Select a recording 

• Choose Action from the menu 

• Choose Open in Sound Editor 
or 

• Select a recording 

• Right click 

• Choose Open in Sound Editor 
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3.5 Using the Sound Editor 
The Sound Editor displays the audio wave from the recording. It allows 
you to edit in a copy of the recording, not in the original. The (edited) 
recording can be saved to disk or sent by e-mail.   
Before attaching the file to an e-mail message, the compression will be 
changed to GSM 6.10. 
 
Use the Audio buttons to play back, pause, 60 sec forward or 60 sec. 
backward in the recording.  

3.5.1 Edit the (copy of) the recording 
Cut, Copy or Paste a section from the recording by selecting it with the 
mouse, clicking and dragging.  
Then 

• Choose Edit from the menu 

• Choose Cut, Copy, Paste or Delete Selection 
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3.5.2 Zooming in on a file 

To zoom in on a recording press the  Zoom in tool button.  
Use the slider at the lower part of the sound Editor to move from the 
beginning to the end of the recording.  
 

 

3.5.3 Undo action  
To undo the last action  

• Press CTRL + Z 
or 

• Choose menu Edit  

• Choose Undo 
Note that only the last action can be undone. Pressing Undo twice will 
resulting redoing the last action after having undone it.  

3.6 Export a selected file 
To export a selected file 

• Click the   Save to Disk tool button  
(the Save As dialogue will open. Select a location for the file and give it 
a name. The file will be saved to in GSM 6.10 codec.)  
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or 

• Choose Menu File (in the sound Editor) 

• Choose Export as *.WAV 
(the Save As dialogue will open. Select a location for the file and give it 
a name. The file will be saved to in GSM 6.10 codec.)  

3.6.1 E-mail a file 
To attach a recording, or the parts of it you did not cut out, to an e-mail 
message: 

•  click   (E-mail tool button).  
 If you use an e-mail program it will open and the file will be attached to 
it.  

• Select the receiver  

• Write your message and send the e-mail.   
 
NOTENOTENOTENOTE: If you use a web based e-mail program like MSN, Hotmail etc. 
You should first export the file and then attach it to your message.   

3.6.2 Export and attach to e-mail 
There are two ways to export a file. From the Sound Editor (described 
above in §3.6) and from the main Menu, described below.  
 

• Select a recording 

• Choose Menu Action  

• Export as *.WAV 

• Choose As Originally recorded or Converted to GSM 6.10 file 
format 

 

 
 
A dialogue opens in which you can specify a file naming scheme and 
location for the export.  
The following tags are allowed in the file name and will be replaced 
with their content. 



 
TagTagTagTag    MMMMeaningeaningeaningeaning    
%ORI Original File name 
%RN Remote name 
%RP Remote phone number 
%LLN Local name 
%LP Local Phone number 
%D Date 
%X Duration 
%IO In or Out (direction) 
 
The drop down box contains pre defined and recently used names.  
 
When ‘Overwrite an existing file’ is not enabled, the file name will be 
appended with (2), (3) etc. necessary to create unique file names.  
It is also possible to replace the predefined name partially or completely 
by a name of your own. 

 
 

• Click OK  
Given you use the predefined name scheme, the file name will look like 
this: 33488919000_____   793471000_______ 22-9-2009 16_39_30 
00_04_10   I.wav 

• Attach the file to your e-mail message as usual. 

3.7 Assigning names to recordings 
The various properties of records are displayed in the corresponding 
columns. For a number of properties it is possible to assign a name to a 
value of that property. 
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For instance the column ‘Remote number’ the remote number of the call 
is displayed if available.  In the column ‘Name remote number’ a name 
can be assigned to a specific remote number. The program is now able 
to assign the same name to all records that share the same remote 
number. If the program does not perform this function automatically 
the function can be called as follows. 

• Choose ActionActionActionAction in the menu. 

• Choose Complete name fields. 
All name fields will be updated where a name can be assigned. For a 
detailed explanation of the columns of the database see § 2.7. 

3.8   Remove encryption 
This menu option removes encryption of the selected file(s).  
The decrypted copy of the recording can be stored on your PC: 
 

• Make a selection of one or any number of recordings 

• Choose Action from the Menu 

• Choose Remove Encryption 

• Enter the PIN Code when prompted to do so 
or 

• Select one or more recordings 

• Right click and  

• choose Remove encryption from the pop up menu.  
 
From then on the recordings are no longer protected. If you want to 
revert to the encrypted format on your PC, you must download the 
recording again from the recorders. Downloading with over writing only 
works with a selection of 1. 
 
If you want to forward an encrypted recording as e-mail, you must first 
store it in decrypted format. It can only then be converted to GSM 6.10 
and forwarded as e-mail. 
 

3.9 Send in e-mail  
Recordings can be attached to an e-mail message from the menu Action, 
from the pop up menu or using the tool button.  
The recording has to be downloaded to the PC before it can be sent as 
attachment to an e-mail. The download will start automatically.  
 

• Select a recording 

• Go to menu Action -> Send as e-mail 

• Wait for the recording to be downloaded and converted to GSM 
6.10 format 
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• Select the receiver of the e-mail from the contacts in your e-mail 
program 

• Write your message 

• Send the item.  
NOTE. This option does not work if you use web mail, like hotmail, NOTE. This option does not work if you use web mail, like hotmail, NOTE. This option does not work if you use web mail, like hotmail, NOTE. This option does not work if you use web mail, like hotmail, 
GmailGmailGmailGmail etc. see §  etc. see §  etc. see §  etc. see § 3.5.13.5.13.5.13.5.1. . . .   
 
or    

• click   (E-mail tool button).  

• Wait for the recording to be downloaded and converted to GSM 
6.10 format 

• Select the receiver of the e-mail from the contacts in your e-mail 
program 

• Write your message 

• Send the item.  
 

 

3.10 Fax converter 
In the special version of the Call Recorder Access System one of the 
options is that it can convert fax recordings back to images. These 
images can be viewed with the built in Fax Viewer.   
There are fax recordings that can not be converted; 28k8 high speed 
faxes and colour faxes.  
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For a recording to be converted to a fax image, it has to be downloaded 
to the PC first, this automatically happens when you select a fax 
recording and press the View fax button.  

Either select the recording and click the View Fax button  in the short 
cut button bar. 
 
Or select the recordings you want to convert 

• Choose Fax in the menu 

• Choose Convert to image 

• Choose Selected Recordings 
The selected fax recordings will be downloaded and converted into 
images. The fax Viewer opens. 

3.10.1 View Faxes 
The fax viewer allows to view all converted faxes in the database.  
 

 
To browse to other faxes in the database, use 1111 and 2222.  
To browse through the pages of a fax, use 3333 and 4444 
To rotate a fax, use 5555 
To fit the fax image to the window or reset the zoom, use 6 6 6 6 
To zoom in and out , use 7777 and 8888. 
To print a fax, use 9 9 9 9 
To save a fax as a .tiff image, use 10101010. 
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4 Managing your archives 

The Call Recorder Access software can work with up to 250 Call 
Recorders of different models which can each handle up to 30 telephone 
lines. Therefore the archives may soon become very large. 
 
Archives can be managed using the Archive menu. The options in the 
menu are: View Archive browser, Archive statistics, Export table to CSV, 
Export Archives to disk, Remote archives, Add the currently opened 
Archive to CD image, Delete the Archive, Recovery, Build CD Archives, 
Import Call Recorder CD.  
The paragraphs below will explain how to work with the Archives.  
 

 
 
The Archive browser can also be opened using the shortcut button 

 

4.1 The Archive Browser 
The Archive Browser is useful to work with more than one archive. It 
helps to find archives quickly. 
 
The Archive browser has four standard directories: The Main archive, 
The Closed Archives, Remote Archives and Recycle Bin.  
The Main Archive is the Working archive.  
When you close an Archive and start a new one, the Closed Archive will 
show up in the list of closed archives.  
Remote Archives can be either created by yourself or by others, placed 
somewhere on the network. To be able to connect to these Remote 
Archives a link should be made.  See § 4.5 for a description.  
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In the example above the Archive started on 16-09-2009 is open. 

4.2 To open a new archive 
When you have installed the software a new archive is made. The 
archive is called ‘Archive ‘ + date, e.g. ‘Archive 19-3-2008’. 
 
When starting a new Archive, the previous Archive will be transferred to 
Closed Archives and it will be given a logical name. For instance: Archive 
16-09-2009 until 2-10-2009. 
A new Archive can only be started as follows: 

• Open the File menu  

• Choose New Archive 
A dialogue opens in which the name and location of the new Archive 
can be specified.  
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The old Archive will be closed and the system will ask for your 
confirmation to rename it. The first date in the new name will be the 
first day after the last day of the previous Closed Archive. If you do not 
want the name of the Archive to change, click No. 

4.3 To begin a new archive at an earlier date 
It is possible to reset the timeframe for an archive to any desired value. 
If you decide that the new archive should contain every recording from 
1-1-2009, you can start the new archive at that date. 
 
A new Archive can only be started as follows: 

• Open the File menu  

• Choose New Archive 
A dialogue opens in which the name and location of the new Archive 
can be specified. Rename the Archive with the first date you want the 
Archive to contain.  
NOTE: Before you download the listing of recordings in this new NOTE: Before you download the listing of recordings in this new NOTE: Before you download the listing of recordings in this new NOTE: Before you download the listing of recordings in this new 
Archive, you have to reset the timeframe for the recorders you want to Archive, you have to reset the timeframe for the recorders you want to Archive, you have to reset the timeframe for the recorders you want to Archive, you have to reset the timeframe for the recorders you want to 
retrieve data from. retrieve data from. retrieve data from. retrieve data from.     
    

 

4.3.1 Reset Timeframe 
It is important to reset the timeframe before you retrieve any data from 
the recorders. You must reset the timeframe for every recorder you are 
working with. 
To reset the timeframe: 

• Choose Tools,  
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• Choose Options 

• Choose the FTP Profiles 

• Select the recorder you want to reset the timeframe of  

• Click Edit 

• Click ‘Reset timeframe 
 

 
A calendar opens in which the new first date of the timeframe can be 
set.  

• Set the date and click OK in the calendar dialogue 

• Click OK in the Edit dialogue 

• Click Apply in the Options dialogue 
Having gone through these steps you can now download the data to the 

Archive by either clicking the Tool button   or choosing the Action 
menu and the option Update database.  

4.4 Closed Archives 
When you have opened a new archive, your earlier archive has become a 
‘Closed Archive’. On the Archive Browser tab, you can find a list of 
closed archives (if there are any). 
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• Click on the Archive icon to view a closed Archive.  
The data will be visible in the main window of the Call Recorder Access 
System. The Archive is still closed, meaning that no records can be 
added.  

4.4.1 To re open a closed Archive: 

• Choose Set current Archive as working archive from the Archive 
menu.  

Be aware that if an old Archive is re opened and set as Working Archive,  
the recordings made between the last day of the old archive and the 
current date will not be in the archive.  
 
Without setting the closed Archive as working archive it is still possible 
to use it.  
Download a (selection of) recording(s) to the PC (see  § 3.4.1) and play it 
back (see § 3.4.5), send it by e-mail  (see § 3.6.1), 
 

4.5 Remote Archives 
Remote Archives are stored outside your PC. They are not different from 
any other archive, but they are ‘read only’.  
 
One obvious way of using a remote archive, and the reason it is named 
so, is by placing an archive on a network location. The archive then is 
maintained from one user’s PC and the other users can access it ‘read 
only’, just to find and listen to recordings. 
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4.5.1 Link to remote Archive 

 
 

• Open Archives in the menu 

• Choose Remote Archives 

• Choose Add link to Archive Browser.  
A window will open in which you can select the Archive you wish to 
connect to.  
 
Connect to the archive by clicking on the icon. The data in the Archive 
will now be shown in the main window of the Call Recorder Access 
System.  

4.5.2 Export an Archive  
Another way of using remote archives is by exporting Closed Archives to 
a mass storage device, a network server or to the hard disk of the PC. 
The link to the exported archive will be added to your list of remote 
archives automatically. 

• Choose Export Archive to disk from the Archive menu 
A dialogue opens in which the location for the export can be selected.  

• Click OK 
The Exported Archive is now added to Remote Archives in the Archive 
Browser.  
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4.6 The Recycle Bin 
The Recycle Bin is like the Windows Recycle Bin. All deleted records and 
recordings from archives are placed in the Recycle Bin. The Recycle Bin 
looks like any other archive, recordings can be played in the same way as 
in a normal archive. Erroneously deleted records can be restored to the 
current archive as follows.  

• Make a selection of records you want to restore. 

• Choose Action in the menu. 

• Choose Restore selection. 
    
NOTE:NOTE:NOTE:NOTE: Restored records are moved to the Working Archive.  

Recordings deleted from the Recycle Bin are permanently lost. 
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5 Search and sort 

To be able to find a (selection of) record(s) quickly, the application has 
extended search and sort possibilities.  

5.1 Sorting the listing 
All records in the database are sorted according to date and time as a 
standard. The sort can be reversed by clicking the head of the column.  

• Click on the head of another column to sort the database 
according to that columns property.  

• Click the column head again to reverse the sort. 

5.2 Searching for records 
The larger the call database, the more important the search function 
becomes.  
Open the Search tab to define your query.  
 

 
 
The obvious properties to use in a query are: Date and Time, Telephone 
number and Name.  

5.2.1 Search by Date and / or Call Duration  
The properties for a Date and Time can be set by clicking the + in front 
of it and selecting the criteria you need. 
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.  
 
There are two ways to define a query according to date. 
In the drop box a number of predefined date intervals is displayed.  

• Select an interval and click OKOKOKOK to execute the query.  
 
Another option would be to define a date range by setting a ‘from’ and 
a ‘to’ date in the calendars. 

• Click the arrow in the drop box ‘From’ 

• Select a From date in the calendar. 

• Click the arrow in the drop box ‘To 

• Select a To date in the calendar. 

• Click SearchSearchSearchSearch to execute the query. 
Alternatively,  enter the date in the From and To boxes and click Search, 
or further define your query using Telephone number, name or other 
options.  
 
In the calendars the current date is circled in red. 
 
To refine your query according to Call Duration enter the range of 
seconds (e.g. 120 – 180 for 2 to 3 minutes etc. )  
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5.2.2 Search by Telephone number 
There are 3 ways to search by Telephone number; Remote number, Local 
number or connected MSN.  
 

• Enter the Telephone number you want to search for 

• Click Search 
Or further define your query using Name and  / or Other properties.  

5.2.3 Search by Name 
There are 3 ways to search by Name; name of Remote, Name Local 
Telephone and name connected MSN.  
 

• Enter the Name you want to search for 

• Click Search 
Or further define your query using or Other properties.  

5.2.4 Search by Other properties  
There is a number of other properties to use or refine the query by; 
Notes, CallRecorder Name, Channel Name, Incoming or Outgoing, 
Recording type. 
  

• Enter a word or words in the Notes field you want to search for 

• Click Search 
Or further define your query using one or more properties .  

• Choose a Call Recorder from the list in the drop box 

• Click Search 
Or further define your query using one or more properties.  

• Enter the Channel number  

• Click Search 
Or further define your query using one or more properties.  

• Choose Incoming or Outgoing 

• Click Search 
Or further define your query using one or more properties.  

• Select a recording type from the drop box.  
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On ‘Recording type’ a 
recording type can be selected 
to further narrow down the 
search results. 
All Telephone Calls, Calls not 
answered, Calls Answered and 
Recorded, From Audio input 
or Microphone, messages on 
Answering machine or 
Recorded faxes.  
 
 Incoming or outgoing calls 
can be selected, as well as 
microphone recordings or 
answering machine messages. 
 

• Click Cancel your Cancel your Cancel your Cancel your QueryQueryQueryQuery 
to return to the main 
archive. 
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6 Archiving recordings on CD’s 

The CR Access System has a special feature to classify archives for CD 
backup purposes and an integrated CD burner module. The archives are 
referred to as ‘CD Archives’. CD Archives are not necessarily archives on 
CD rather than archives whose size is limited to guarantee that they can 
be copied to CD. CD Archives are stored on the hard disk of your PC.  CD 
archives have a different structure and are therefore limited to 12000 
entries.  
 
Quite often when you want to place an archive on CD it must be spread 
across multiple CD’s. The software will therefore create several 
databases. This will allow you to open the CD’s one by one as a complete 
archive from the software. It is not necessary to copy them all back to 
the PC. 
CD archives can be used for other purposes. You could create larger sub 
archives to fit on DVD, or you could copy the archive to another medium 
such as a memory card.  
The most important feature of CD Archives is that their size is monitored 
not to exceed the maximum size of a CD recordable. If the size of a CD 
Archive nears the maximum size of a CD the program will create a next 
CD Archive, up to a maximum of 10 archives. 

6.1 Add recordings to CD Archives 
There are several ways to add recordings to the CD archives: 

Add a selection such as the currently selected recording. 
Make a query, then add the archive, which will only add the query 
Add the full archive, usually as a full back up 

 
To add a selection of recordings to the CD Archive: 

• Make a selection of recordings you want to add to the CD Archive. 

• Click Add to CD Archive Tool button . 
or 

• Open the Archive menu 

• Choose Build CD Archive. 

• Choose Add Selection. 
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To add a query to the CD archive: 

• Make a query. 

• Click Add to CD Archive Tool button . 
or 

• Open the Archive menu 

• Choose Build CD Archive. 

• Choose Add Complete Archive. 
 

To add queries from several archives to the CD archive open the Archive 
browser, select another archive and repeat the actions: 
  

NOTENOTENOTENOTE As is the case in the current archive the program does not 
monitor the files copied to the CD Archives. It is therefore possible to 
add the same recordings to the CD Archives twice!  

6.2 View CD Archives 
CD Archives are very much like normal archives. As long as the CD 
Archives are on your hard disk these archives can be opened and viewed 
as follows. 

• Choose FileFileFileFile in the menu. 

• Choose Archive on CD. 

• Choose Open Database on CD. 

• Select folder CD0 to CD9. 

• Open the archive in the selected folder. 
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In the CD Archive it is only possible to view the data of the recordings. It 
is not possible to play recordings from a CD Archive. Only when the CD 
Archive is copied to a CD recordable the recordings can be played. If the 
CD Archive has already been copied to CD the archive can be opened as 
follows: 

• Choose FileFileFileFile in the menu. 

• Choose Archive on CD. 

• Select Open database on existing CD. 
 
A dialogue similar to the Working archive dialogue appears in which the 
archive on CD can be selected and opened. 

6.3 Make back-up on CD 
The CD Archives as they are made by the program will always fit on your 
CD recordable (see also the following paragraph). To copy the CD 
Archives to CD: 

• Choose ArArArArchivechivechivechive in the menu. 

• Choose Build CD Archive. 

• Choose Burn CD 
You will see the following: 
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In the example above the CD Archive is for only 2 CD’s. The user has 
already clicked the Button ‘Check CD in burner’ and the software reports 
in the ‘Status’ line it is ready to make the CD. 

• Now click the button ‘Burn CD 0’.  
The burning process will start. The status column will keep you informed 
about the phase of the burning and the progress bar will show you the 
progress. When the first CD is finished it will open the CD drive and 
prompt you to insert the next CD. This will repeat until all CD’s are 
finished. 
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Since the software takes care of the progress, you cannot make more 
CD’s until you click the button ‘Make another Batch’. 
 
The CD burner can also handle small back-up archives that you may 
want to place on a sub directory on the CD. This option will only appear 
when only one CD is to be made.  

• Select the option  

• Enter the name of the subdirectory on the CD.  
You can add one or more archives to the same CD at any time before 
actually burning the CD.  

6.4 To clear the CD Archives 
It is important to clear the old archives after making the CD’s. This will 
help you to avoid duplications: 

• Choose ArchiveArchiveArchiveArchive in the menu. 

• Choose Build CD Archive. 

• Choose Erase new CD Archives 
 
Because of the risk of duplicates if you do not keep track of the contents 
of the CD Archives, in every session the first time you add something to 
CD Archives from earlier sessions, a warning will be displayed. 

6.5 Setting the size of the CD Archives 
Because there are differences in CD recordable storage capacity the 
maximum size of the CD Archives can be set to a desired value. 

• Open the ToolsToolsToolsTools menu 

• Choose Options. 

• Select the Security and CD's tab. 
 
In Building CD ArchivesBuilding CD ArchivesBuilding CD ArchivesBuilding CD Archives you can set the Maximum megabytesMaximum megabytesMaximum megabytesMaximum megabytes on CD on CD on CD on CD 
value. Standard this value is set to 700 Mb.  
 

 

6.6 Import Call Recorder CD 
This refers to CD’s made by a Call Recorder with an integrated CD drive. 
 
It is possible to import recordings from a Call Recorder CD into the 
Archive.  
NOTE: The CD must have a ‘directory’ created on it by a Call Recorder. 

• Choose ArchiveArchiveArchiveArchive in the menu. 
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• Select Import Call Recorder CD. 
A new dialogue will open in which the recordings on the CD can be 
selected.  

• Select a recording  

• click Open.  
The selected recording will be imported in the archive you are working 
with at that moment. .  

NOTENOTENOTENOTE: It is not possible to import a selection of recordings. 
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7 Encrypted recordings 

All Vidicode Call Recorders have the option to store recordings in an 
encrypted format. This is always done using the so called Crypto Card, 
which is an IC card, very similar to a credit card.  

 
 
To decrypt and play the recordings a card from the same set is required. 
To open that card for decryption a PIN Code must be entered. 
 
The encryption is considered safe and hard to break. The security level 
can be compared with the security of electronic banking systems. 
 
There are several encryption systems with slightly different purposes, 
such as privacy protection, network security and evidence of 
authenticity. There is no difference between them for the Software. 
 
The CR Access System will automatically recognise encrypted recordings 
and display the following warning: “CryptoCard needed but not found”  

 

7.1 Configuration for decryption 
To play encrypted recordings the following is needed: 
 

• A chip card reader installed on the PC 
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• A Crypto Card with the same number as used in the recorder 

• The PIN Code of the card 
 
Most Chip Card readers are for connection to the USB port. A 
compatible card reader can be ordered from your Vidicode dealer as 
part number 1359.  
 
Other card readers may work as well. They must be compatible with the 
ISO 7816 T=1 protocol. It is recommended to install the drivers of the 
card reader before connecting the reader. 
 
The software will only load the drivers for the card reader after you 
enabled this in the program options: 
 

• Select Tools from the Menu 

• Select Options  

• Choose Security and CD’s 

• On Crypto Card functions, enable ‘Use Card Reader’ 
 
The reason this must be enabled is that, when no card reader is 
connected the software may take a long time to boot because it 
searching for the reader. 
 

7.2 To play a recording using the Crypto Card 
The recording will play as usual, but first prompt you for the  PIN Code. 
 

 
 
Various errors may occur: 
 

• You are using a card that does not match the recording 

• You entered the wrong PIN Code 

• A wrong PIN Code has been used 4 times and therefore the card is 
blocked, and has to be unlocked 
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In case this happens you will be informed with the appropriate error 
message and instructions. 
 
One of the CryptoCard settings in Program Options is the timeout of the 
PIN Code in minutes. When working with many recordings from the 
same set of cards you do not want to enter the PIN Code every time. The 
software will use the same PIN Code but it will expire when you do not 
use it for a certain number of minutes.  
 

7.3 To store a recording in decrypted format 
Recordings can be stored in a decrypted format on your PC: 
 

• Make a selection of one or any number of recordings 

• Choose Action from the Menu 

• Choose Remove Encryption 

• Enter the PIN Code when prompted to do so 
 
From then on the recordings are no longer protected. If you want to 
revert to the encrypted format on your PC, you must download the 
recording again from the recorders. Downloading with over writing only 
works with a selection of 1. 
 
If you want to forward an encrypted recording as e-mail, you must first 
store it in decrypted format. It can only then be converted to GSM 6.10 
and forwarded as e-mail. 
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8 Charts and Tables 

The software has a Charts and Tables option to analyze the telephone 
traffic. 

• Open the Tools menu  

• Select Charts and Tables 
or 

• Click the Tool bar button  
A dialog will open in which you can specify what kind of information 
you want to display.   The displayed information will be about the entire 
database, or about a pre defined selection. Learn more about how to 
make a selection in § 5.2 
 

 
 
The options are: Call duration, Wait before answer, Time distribution 
during day, Local number, Remote number. 
 

• Choose one of the options  

• Click Create 
The example in the picture below is the distribution in time over the day 
of all office calls in a certain period as a Stacked bar chart. 
There are three different display options: Stacked bar chart, Clustered 
bar chart or Table.  

• Open File in the Charts and Tables window and make your choice.  
 
The charts show: 

• Incoming calls answered 

• Outgoing calls answered 

• Incoming calls unanswered 

• Outgoing calls unanswered 
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The information displayed by the chart can show different aspects of call 
behaviour directly and problems apparent if the input data is properly 
selected. 
The information displayed can also be printed or saves as a .csv file, 
which can then, in turn, be opened in an Excel sheet. 
 

 
 

• Select Chart from the File menu 

• Choose Save image or Print… 
Or 

• Select Table from the File menu 

• Choose Export table to csv or Print.. 
 The image can be saved in a number of standard file formats in a 
directory you choose. The .csv file can be stored in a directory of your 
choice as well.  
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9 Other Program options 

A number of options has not been described yet, because they have a 
function not directly related to archiving recordings or play back of 
recordings.  

9.1 File menu 
All options in the file menu have been described.  
New Archive can be found in § 4.2.  
Open Archive is described in § 4.4.1.  
The options are to open the Working Archive, or an Old Archive § 4.4.  
The section Archive on CD is described in § 6 

9.1.1 Print list of recordings 
The File menu also has an option Print list of recordingsPrint list of recordingsPrint list of recordingsPrint list of recordings.  

• Make a selection of recordings as described in § 5.2 

• Choose Print list of recordings 

• Select the printer you want it to be printed by 
The list will be an image of the list you see on screen.  

9.2 Archive menu  
View Archive browser is described in § 4.1 
Export table to .csv is described in §  
Export  Archive to Disk is described in § 4.5.2 
Remote Archives is described in § 4.5 
Add currently open Archive to CD image is described in § 6 
Build CD Archives is described in § 6.1 
Import Call Recorder CD is described in §6.6 

9.2.1 Archive statistics 
This option gives information on the currently selected Archive 
As shown in the figure below.  
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9.2.2 Delete this Archives 
With this option an entire Archive can be deleted. A dialogue will open 
to ask if you are quite sure you want to delete an entire archive. The 
recordings on the call recorder will still be there, it is just the listing of 
the recordings and the recordings you may have downloaded to your PC 
that will be deleted.  

9.2.3 Recovery 
 Use this option if the call listing database (archive.mdb) has become 
corrupted and has been replaced with an empty one. This function 
restores the call listing from the available recordings in the sub 
directories 1 up to 31. Records that have not been downloaded before 
can not be restored this way.  
 

9.3 The View menu 
The view menu has the options:  

9.3.1 Toolbar  

• enable this to be able to see and use the toolbar 

 

9.3.2 Left Area 

• Enable this to see the Archive and Search tab in the left area. 
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9.3.3 Network communication details  
Enable this option to see the network communication details at the 
bottom of the main window.  

 
 

9.3.4 Move to system tray. 
Moves the program to the Windows System tray. The program is active, 
but invisible until you restore it by clicking the icon in the System tray.  
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10 On Line Product Update 

Like most software products the CR Access System can be updated on 
line to the latest version. 
 
From the menu select ‘Help’ and ‘On Line Product Update’. 
 
The update dialogue will open. Click ‘Check for Updates’. You will see 
something like this: 
 

 
 
Click ‘Execute Update’ when you want to install the update. 
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11 Acknowledgements 

Use of the CR Access System in combination with a certain number of 
Call Recorders bears a certain reasonability with it. Below you will find a 
discussion about this subject and our view upon using the program.  

11.1 Privacy 
When recording telephone conversations the privacy of your 
conversation partner must be considered.  
In some countries there is an obligation to notify your conversation 
partner of the recording. Check your national legal obligations on this 
and other issues concerning the use of the CR Access System. 
In the United States, the Federal government requires that only one 
person involved in a conversation must know the call is being recorded. 
However, each state has its own legislation. The vast majority of states 
have laws complying with the Federal ‘one party’ requirement. A few 
states, e.g. Florida, do require both parties to be aware the call is being 
recorded. 
Call Recorders can comply both with the one party or two party 
requirements. One party simply means the person with the Call Recorder 
knows the call is being recorded. Compliance is made with two party 
requirements by sounding a notification tone during the call. 

11.2 Liability 
Recorded calls can be of vital importance to companies or other 
organizations. We cannot guarantee the correct functioning of the 
program under all circumstances. We deny any responsibility for the loss 
of information or other damages due to the use of the CR Access 
System. 
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